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Important Information

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND
CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE
CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD
OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE)
OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER
LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE
SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE
BOUND BY THE SAME.

This document contains confidential information that is subject to U.S. and international copyright laws
and treaties. No part of this document may be reproduced in any form without the written
authorization of TIBCO Software Inc.

TIBCO and Two-Second Advantage are either registered trademarks or trademarks of TIBCO Software
Inc. in the United States and/or other countries.

Enterprise Java Beans (EJB), Java Platform Enterprise Edition (Java EE), Java 2 Platform Enterprise
Edition (J2EE), and all Java-based trademarks and logos are trademarks or registered trademarks of
Oracle Corporation in the U.S. and other countries.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

THIS SOFTWARE MAY BE AVAILABLE ON MULTIPLE OPERATING SYSTEMS. HOWEVER, NOT
ALL OPERATING SYSTEM PLATFORMS FOR A SPECIFIC SOFTWARE VERSION ARE RELEASED
AT THE SAME TIME. SEE THE README FILE FOR THE AVAILABILITY OF THIS SOFTWARE
VERSION ON A SPECIFIC OPERATING SYSTEM PLATFORM.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO
SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S)
AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

Copyright © 2001-2016 TIBCO Software Inc. All rights reserved.

TIBCO Software Inc. Confidential Information
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TIBCO Documentation and Support Services

Documentation for this and other TIBCO products is available on the TIBCO Documentation site. This
site is updated more frequently than any documentation that might be included with the product. To
ensure that you are accessing the latest available help topics, please visit:

https://docs.tibco.com

Product-Specific Documentation

Documentation for TIBCO products is not bundled with the software. Instead, it is available on the
TIBCO Documentation site at https://docs.tibco.com/products/tibco-activematrix-businessworks-plug-
in-for-osisoft-pi-system. To directly access documentation for this product, double-click the following
file:
TIBCO_HOME/release_notes/TIB_bwpluginpi_version_docinfo.html

where TIBCO_HOME is the top-level directory in which TIBCO products are installed. On Windows,
the default TIBCO_HOME is C:\Program Files\tibco. On UNIX systems, the default TIBCO_HOME
is /opt/tibco.

The following documents for this product can be found on the TIBCO Documentation site:

● TIBCO ActiveMatrix BusinessWorks Plug-in for OSIsoft PI System Installation

● TIBCO ActiveMatrix BusinessWorks Plug-in for OSIsoft PI System User's Guide

● TIBCO ActiveMatrix BusinessWorks Plug-in for OSIsoft PI System Release Notes

How to Contact TIBCO Support

For comments or problems with this manual or the software it addresses, contact TIBCO Support:

● For an overview of TIBCO Support, and information about getting started with TIBCO Support,
visit this site:

http://www.tibco.com/services/support

● If you already have a valid maintenance or support contract, visit this site:

https://support.tibco.com

Entry to this site requires a user name and password. If you do not have a user name, you can
request one.

How to Join TIBCO Community

TIBCO Community is an online destination for TIBCO customers, partners, and resident experts. It is a
place to share and access the collective experience of the TIBCO community. TIBCO Community offers
forums, blogs, and access to a variety of resources. To register, go to the following web address:

https://community.tibco.com
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Product Overview

TIBCO ActiveMatrix BusinessWorks™ Plug-in for OSIsoft PI System supports data exchange between
the PI server and TIBCO ActiveMatrix BusinessWorks™. It offers query capabilities using RPC and
JDBC and publish capabilities from the PI server.

TIBCO ActiveMatrix BusinessWorks is a leading integration platform that can integrate a wide variety
of technologies and systems within enterprises and on cloud. TIBCO ActiveMatrix BusinessWorks
includes an Eclipse-based graphical user interface (GUI) provided by TIBCO Business Studio™ for
design, testing, and deployment. To familiarize yourself with TIBCO ActiveMatrix BusinessWorks, see
the TIBCO ActiveMatrix BusinessWorks documentation.

TIBCO ActiveMatrix BusinessWorks Plug-in for OSIsoft PI System plugs into TIBCO ActiveMatrix
BusinessWorks and adds an OSIsoft PI System palette into the palette library of TIBCO Business Studio.
For more information, see OSIsoft PI System Palette.

With this plug-in, you can:

● Create new tags into the PI server.

● Modify the attributes of existing tags.

● Retrieve tag definitions.

● Retrieve or set tag values, including the latest tag value, the archival tag value, and the historical tag
values.

● Monitor the changes of the tag values.

Regarding how to use the plug-in, see Getting Started.
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Getting Started

This tutorial is designed for the beginners who want to use TIBCO ActiveMatrix BusinessWorks Plug-in
for OSIsoft PI System in TIBCO Business Studio.

All the operations are performed in TIBCO Business Studio. See TIBCO Business Studio Overview to
get familiar with TIBCO Business Studio.

A basic procedure of using TIBCO ActiveMatrix BusinessWorks Plug-in for OSIsoft PI System includes:

1. Creating a Project

2. Creating an OSIsoft PI System Connection

3. Configuring a Process

4. Testing a Process

5. Deploying an Application

Creating a Project
The first task using the plug-in is creating a project. After creating a project, you can add resources and
processes.

An Eclipse project is an application module configured for TIBCO ActiveMatrix BusinessWorks. An
application module is the smallest unit of resources that is named, versioned, and packaged as part of
an application.

Procedure

1. Start TIBCO Business Studio using one of the following ways:

● On Microsoft Windows: click Start > All Programs > TIBCO > TIBCO_HOME > TIBCO
Business Studio version_number > Studio for Designers.

● On Linux: run the TIBCO Business Studio executable file located in the TIBCO_HOME/studio/
version_number/eclipse directory.

2. From the menu, click File > New > BusinessWorks Resources to open the BusinessWorks Resource
Wizard.

3. In the "Select a wizard" dialog, click BusinessWorks Application Module and click Next to open
the New BusinessWorks Application Module wizard.

4. In the Project dialog, configure the project that you want to create:
a) In the Project name field, enter a project name.
b) By default, the created project is located in the workspace currently in use. If you do not want to

use the default location for the project, clear the Use default location check box and click Browse
to select a new location.

c) Use the default version of the application module, or enter a new version in the Version field.
d) Keep the Create empty process and Create Application check boxes selected to automatically

create an empty process and an application when creating the project.
e) If you want to create a Java module, select the Use Java configuration check box.

A Java module provides the Java tooling capabilities.
f) Click Finish to create the project.

Result

The project with the specified settings is displayed in the Project Explorer view.
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Creating an OSIsoft PI System Connection
After creating a project, add an OSIsoft PI System Connection shared resource to create a connection
between the plug-in and the PI server.

According to the type of the activity, create one of the following connections:

● For the JDBC Query activity, create an OSIsoft PI System JDBC connection.

● For the AF type activities, that is the AF TagDefinition, AF TagEventListener, and AF TagValues
activities, create an OSIsoft PI System AF connection.

The OSIsoft PI System AF Connection shared resource is only available on Windows.

In this tutorial, the JDBC Query activity is used as the example, therefore, an OSIsoft PI System JDBC
connection must be created. The OSIsoft PI System AF connection can be created in the same way.

Prerequisites

Ensure that you have created a project. For more information, see Creating a Project.

Procedure

1. Expand the project in the Project Explorer view.

2. Right-click the Resources folder and click New > OSIsoft PI System JDBC Connection to open the
OSIsoft PI System JDBC Connection Resource dialog.

3. Specify the resource folder, package name, and resource name of the connection if you do not want
to use the default configurations. Click Finish to open OSIsoft PI System JDBC Connection Editor.
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4. In the Configuration panel, configure the shared resource.

For detailed information about the configuration parameters, see OSIsoft PI System JDBC
Connection.

5. Click Test Connection to validate the connection.

Configuring a Process
After creating a project, an empty process is created. You can add activities to the empty process to
complete a task.

For example, use the JDBC Query activity to get the snapshot tag value, that is the tag value with the
most recent timestamp.

Prerequisites

Ensure that you have created an empty process and an OSIsoft PI System JDBC connection. For more
information, see Creating a Project and Creating an OSIsoft PI System Connection. If you have not
created an empty process when creating a project, see TIBCO ActiveMatrix BusinessWorks Application
Development for more information about how to create a process.

Procedure

1. In the Project Explorer view, click the created project and open the empty process from the
Processes folder.

2. Select an activity from the Palette view and drop it in the Process editor.
For example, select and drop the Timer activity from the General Activities palette and the JDBC
Query activity from the OSIsoft PI System palette.
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3. Drag the  icon to create a transition between the added activities.

4. Configure the added activities.
For more information about the configuration parameters, see OSIsoft PI System Palette.

5. Click File > Save to save the project.

Testing a Process
After configuring a process, you can test the process to check if the process completes your task.

Prerequisites

Ensure that you have configured a process. For more information, see Configuring a Process.

Procedure

1. On the toolbar, click  Debug > Debug Configurations.

2. Click BusinessWorks Application > BWApplication in the left panel.
By default, all the applications in the current workspace are selected in the Applications tab. Ensure
that only the application you want to debug is selected in the Applications tab in the right panel.

3. Click Debug to test the process in the selected application.
TIBCO Business Studio changes to the Debug perspective. The debug information is displayed in
the Console view.
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4. In the Debug tab, expand the running process and click an activity.

5. In the upper-right corner, click the Job Data tab, and then click the Output tab to check the activity
output.

Deploying an Application
After testing, if the configured process works as expected, you can deploy the application that contains
the configured process into a runtime environment, and then use the bwadmin utility to manage the
deployed application.

Before deploying an application, you must generate an application archive, which is an enterprise
archive (EAR) file that is created in TIBCO Business Studio. For more information, see TIBCO Business
Studio Overview.

Deploying an application involves the following tasks:
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1. Uploading an application archive

2. Deploying an application archive

3. Starting an application

For more information about how to deploy an application, see TIBCO ActiveMatrix BusinessWorks
Administration.

TIBCO Business Studio Overview
TIBCO Business Studio is an Eclipse-based integration development environment that is used to
design, develop, and test ActiveMatrix BusinessWorks applications.

TIBCO Business Studio provides a workbench in which you can create, manage, and navigate resources
in your workspace. A workspace is the central location on your machine where all data files are stored.

The workbench consists of:

1. Menu: contains menu items such as File, Edit, Diagram, Navigate, Search, Project, Run, Window,
and Help.

2. Toolbar: contains buttons for frequently used commands such as New , Save , Enable/

Disable Business Studio capabilities , Create a new BusinessWorks Application Module ,

Create a new BusinessWorks Shared Module , Debug , Run , and so on.

3. Perspective: contains an initial set and layout of views that are required to perform a certain task.
TIBCO Business Studio launches the Modeling perspective by default. You can change the
perspective from the menu Window > Open Perspective > Perspective_Name.

4. View: displays resources. For example, the Project Explorer view displays the ActiveMatrix
BusinessWorks applications, modules, and other resources in your workspace, while the Properties
view displays the properties for the selected resource. You can open a view from the menu Window
> Show View > View_Name.

5. Editor: provides a canvas to configure, edit, or browse a resource. Double-click a resource in a view
to open the appropriate editor for the selected resource. For example, double-click an ActiveMatrix
BusinessWorks process (MortgageAppConsumer.bwp) in the Project Explorer view to open the
process in the editor.
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6. Palette: contains a set of widgets and a palette library. A palette groups activities that perform similar
tasks and provides quick access to activities when configuring a process.
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OSIsoft PI System Connection

This plug-in provides two shared resources that you can use to create a connection to the PI server.

There are two types of connections in this plug-in, OSIsoft PI System JDBC connection, which is used
for the JDBC Query activity and OSIsoft PI System AF connection, which is used for the AF activities.

OSIsoft PI System AF Connection
With the OSIsoft PI System AF Connection shared resource, you can create a connection between the
plug-in and a PI AF server. This shared resource is used for the AF activities, including the AF
TagDefinition, AF TagEventListener, and AF TagValues activities.

General

In the General panel of OSIsoft PI System AF Connection Editor, you can specify the package that
stores the OSIsoft PI System AF Connection shared resource, and the name and description of the
shared resource.

The following table lists the fields in the General panel:

Field
Module
Property? Description

Package No The name of the package where the new shared resource is added.

Name No The name to be displayed as the label for the shared resource in the
process.

Description No A short description for the shared resource.

Configuration

In the Configuration panel of OSIsoft PI System AF Connection Editor, you can specify information of
the PI AF server that the plug-in connects to.

The following table lists the fields in the Configuration panel:

Field
Module
Property? Description

Server Name Yes The IP address or name of the machine where the PI
server is installed.

Security Type No The authentication mode used for connecting to the PI
server:

● User Name: the user name and password are
required for connecting to the PI server.

● PI Trust: you can log on to the PI server
automatically without entering the user name and
password.
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Field
Module
Property? Description

User Name Yes The user name of the PI user used to connect to the PI
server.

This field is only available when you select User Name
in the Security Type list.

Password Yes The password used to connect to the PI server.

This field is only available when you select User Name
in the Security Type list.

Server Role Yes The role of the server you want to use when connecting
to the PI server.

Server role is relevant in high-availability environments
with two or more replicated servers.

Supported server roles in this field include Any,
PreferPrimary, and RequirePrimary.

For more information, see the PI SDK documentation.

Test PI Point Yes The name of an existing tag on the PI server.

This point is used to check the connectivity to the PI
server. The default value in this field is SINUSOID.

If you use a customized test point, make sure that the
connection to the PI server is successful. Otherwise, the
runtime reconnection to the PI server always fails.

Maximum Number of
Reconnect Attempts

Yes The maximum number of attempts for the plug-in to
reconnect to the PI server when the server is unavailable.

The default value is -1.

Number of Reconnect
Attempts Before
Suspending Impacted
Services(s)

Yes The total number of automatic reconnection attempts.

The default value is 5, which indicates that there is no
restriction on the times of reconnection.

Interval Between
Reconnect
Attempts(milliseconds)

Yes The interval between detected connection failure and
automatic reconnection in milliseconds.

The default value is 1000.

Test Connection No When you finish the configuration, click this button to
test whether the parameters are set correctly.
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OSIsoft PI System JDBC Connection
With the OSIsoft PI System JDBC Connection shared resource, you can create a connection between the
plug-in and the PI server. This shared resource is used for the JDBC Query activity.

General

In the General panel of OSIsoft PI System JDBC Connection Editor, you can specify the package that
stores the OSIsoft PI System JDBC Connection shared resource, and the name and description of the
shared resource.

The following table lists the fields in the General panel:

Field
Module
Property? Description

Package No The name of the package where the new shared resource is added.

Name No The name to be displayed as the label for the shared resource in the
process.

Description No A short description of the shared resource.

Configuration

In the Configuration panel of OSIsoft PI System JDBC Connection Editor, you can specify information
of the PI JDBC server that the plug-in connects to.

The following table lists the fields in the Configuration panel:

Field
Module
Property? Description

Host Yes The IP address or name of the machine where the PI server is
installed.

Server Yes The server selected for connection.

User Name Yes The user name used to log on to the PI server.

If the host machine belongs to a certain domain, you can enter
Domain/User Name in this field.

Password Yes The password required for connection.

Test
Connection

No When you finish the configuration, click this button to test whether
the parameters are set correctly.
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OSIsoft PI System Palette

A palette groups the activities that connect to the same external applications. Once TIBCO ActiveMatrix
BusinessWorks Plug-in for OSIsoft PI System is installed, an OSIsoft PI System palette is added into
the palette library.

The OSIsoft PI System palette contains the following activities:

● AF TagDefinition: retrieves tag definitions from the PI server, modifies tag definitions, and creates
new tags into the PI server.

● AF TagEventListener: listens on tag updates and then fetches the updated entries.
● AF TagValues: retrieves tag values, including the latest value, historical values, and the archival

value, and it sets tag values.
● JDBC Query: gets tag definitions and retrieves tag values, including the latest value and historical

values.
The AF type activities are only available on Windows.

AF TagDefinition
By using the AF TagDefinition activity, you can retrieve tag definitions from the PI server, modify tag
definitions, and create new tags into the PI server.

General

In the General tab, you can specify the name of the activity in the process, establish a connection to the
PI AF server, and select what type of operation you want to perform.

The following table lists the fields in the General tab of the AF TagDefinition activity:

Field
Module
Property? Description

Name No A unique name of the activity in a process.

Server
Connection

Yes The PI AF shared resource selected to connect to a PI AF server.

Click the  icon to select an OSIsoft PI System AF connection
resource. If no matching OSIsoft PI System AF connection resource is
found, click Create Shared Resource to create one.

Operation No The type of operation you want to perform:

● getTagDefinitions: retrieves tag definitions.

● upsertTags: creates or modifies tag definitions.

Description

In the Description tab, you can type a short description for the AF TagDefinition activity.

Input

In the Input tab, you can specify the tag that you want to retrieve, modify, or create for the AF
TagDefinition activity.

Input elements in this tab are different depending on the operation you select in the General tab:
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● If you select the getTagDefinitions operation, see the Input items for getTagDefinitions table for
descriptions of the input items.

● If you select the upsertTags operation, see the Input items for upsertTags table for descriptions of
the input items.

Input items for getTagDefinitions

The following table provides descriptions of the input items for the getTagDefinitions operation.

Input Item Data Type Required Description

requestHeader Complex No The request message header.

For descriptions of all the attributes in this
element, see Attributes in requestHeader.

filterExpression String Yes The expression used for filtering the returned
tag definitions.

The expression format must correspond with
the method you specify in the useMethod
element. For example, to get all tags starting
with a:

● If the useMethod element is set to
useGetPoints, type "a*" in this field.

● If the useMethod element is set to
useGetPointsSql, type "tag:a*" in this
field.

useMethod String No The filtering method used to evaluate the
filtering expression in the filterExpression
element.

Enter one of the following methods in this
field:

● useGetPoints (default): the method that
uses PI server specific syntax.

● useGetPointsSql: the method that uses
SQL-like syntax.

Input items for upsertTags

The following table provides descriptions of the input items for the upsertTags operation.

Input Item Data Type Required Description

requestHeader Complex No The request message header.

For descriptions of all the attributes in this
element, see Attributes in requestHeader.

tagList Complex Yes The list of tag definitions that you want to
create or modify.
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Input Item Data Type Required Description

whenExistsModify Boolean No The parameter that specifies the tag definitions
to be either created or modified.

● If it is set to false, the tag definitions are
to be created.

● If it is set to true, the tag definitions are to
be modified.

By default, the value in this field is false.

Output

In the Output tab of the AF TagDefinition activity, you can find the results corresponding to your
inputs.

The output elements in this tab are different depending on the operation name you select in the
General tab.

All the time is in UTC time zone.

The following table lists the output items for the getTagDefinitions and upsertTags operations:

Output Item Data Type Description

If you select the getTagDefinitions operation, the following output items are available:

responseHeader Complex The response message header.

tagDefinitionList Complex The list of tag definitions that match the provided filtering
expression returned by the PI server.

For descriptions of all the attributes in this item, see 
Attributes in tagDefinitionList.

If you select the upsertTags operation, the following output items are available:

responseHeader Complex The response message header.

failureList Complex A list of tags that are operated in the wrong way.

pointsCreated Integer The number of tags that are successfully created.

pointsModified Integer The number of tags that are successfully modified.

Fault

In the Fault tab, you can find the error messages and error codes of the AF TagDefinition activity. For
more information about errors, see Error Codes.

The following table lists the error schema elements in the Fault tab:
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Element Name Data Type Description

msg String Displays the error message.

msgCode String Displays the error code.

Attributes in requestHeader
In this section, you can find the descriptions of all the attributes for the requestHeader item in the
Input tab.

The following table provides the descriptions of all the attributes in the requestHeader item:

Attribute Name Data Type Required Description

consumer String No The identifier of the message user.

provider String No The identifier of the message provider.

timestamp String No The date and time when the message is
generated.

messageId String No The globally unique identifier of the message.

correlationId String No The correlation identifier that can be used for
correlating multiple messages.

Attributes in tagDefinitionList
In this section, you can find the descriptions of all the attributes for the tagDefinitionList item in the
Output tab.

The tagDefinitionList item is displayed in the Output tab only when you choose getTagDefinitions
from the Operation list in the General tab.

The following table provides the descriptions of all the attributes in the tagDefinitionList item:

Attribute Name Data Type Description

pointName String The name of the tag on the PI server.

descriptor String The description of the PI tag.

piServerName String The name of the PI server that records the tag.

pointClass String The attribute that specifies point class from the point
classes that belong to the PI server.

pointType String The attribute that specifies the data type for the values that
a point stores.

Supported point types include: Digital, Timestamp,
Float64, Float32, Float16, Int32, Int16, String, and Blob.

pointSource String The attribute that identifies the source of data for a PI
point.
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Attribute Name Data Type Description

changeDate String The last time when the PI point was changed.

creationDate String The time when the PI point was created.

digitalSet String The name of the digital set.

This attribute is only relevant when the pointType
attribute is Digital.

engineeringUnits String The default unit of measurement for the PI point.

extendedDescription String Optional extended description for the PI point.

sourceTag String Reference to another PI point.

Data stream of this PI point is used as the source for the
given PI point.

displayDigits String The attribute that determines the display precision of PI
point values.

archiving String The attribute that enables or disables values archiving.

Supported values are 0 and 1.

scan String The attribute that enables or disables interface scanning.

Supported values are 0 and 1.

compressing String The attribute that determines whether snapshot events are
selected to be sent to the archive file for storage.

Supported values are 0 and 1.

zero String The lowest possible value of a PI point.

span String The range between the maximum and minimum values for
a point.

The sum of zero and span determines the highest possible
value.

excdev String Exception deviation, the set of values that define a
deadband used for exception reporting.

If this attribute is used, the excdevpercent attribute is
recalculated.

excdevpercent String Percentage of exception deviation.

If this attribute is used, the excdev attribute is recalculated.

compdev String Compression deviation, the compression algorithm used
to reduce the data flow from the interfaces to the PI server.

If this attribute is used, the compdevpercent attribute is
recalculated.
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Attribute Name Data Type Description

compdevpercent String Percentage of compression deviation.

If this attribute is used, the compdev attribute is
recalculated.

AF TagEventListener
The AF TagEventListener activity publishes notification messages each time values of the tags that you
listen to are changed. Therefore, by using this activity, you can listen to tag updates and fetch the
changed entries.

General

In the General tab, you can specify the name of the activity in the process, establish a connection to the
PI AF server, select the tags to listen to, and define how often the tag updates are to be checked.

The following table lists the fields in the General tab of the AF TagEventListener activity:

Field
Module
Property? Description

Name No A unique name of the activity in a process.

Server
Connection

Yes The PI AF shared resource selected to connect to a PI AF server.

Click the  icon to select an OSIsoft PI System AF connection
resource. If no matching OSIsoft PI System AF connection resource
is found, click Create Shared Resource to create one.

Polling
Interval
(milliseconds)

Yes The polling interval of publishing, which specifies how often in
milliseconds the tags in the Tag List are checked for value updates.

Tag List No The list of tags that you listen to:

● Add: inserts a new row at the bottom of the list, in which you can
type the name of the tag to listen to.

● Remove: deletes a selected row in the list. When the table is
empty, this button is disabled.

● Add Tags From File: quickly adds multiple tags into the list at a
time by loading a .txt or .csv file encoded in ASCII with one
tag name per row.

If the tags you listen to do not exist in the PI server, warning
messages are displayed in the Console view at run time.

Description

In the Description tab, you can type a short description for the AF TagEventListener activity.

Advanced

In the Advanced tab, you can specify the object class of the entry that you want to search for.
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The following table lists the fields in the Advanced tab of the AF TagEventListener activity:

Field
Module
Property? Description

Sequence Key No This field contains an XPath expression that specifies the order in
which the process runs. Process instances with sequencing keys that
have the same value are executed sequentially in the order in which
the process instances were created.

Custom Job Id No This field contains an XPath expression that specifies a custom job
ID for the process instance. This ID is displayed in the TIBCO
Administrator View Service dialog, and it is also available in the
$_processContext process variable.

Conversations

A conversation represents two or more related message exchanges in the same process that are
correlated by the BusinessWorks engine. In the Conversations tab, you can initiate a conversation by

clicking the Add New Conversation icon .

For more information about how to use conversations, see TIBCO ActiveMatrix BusinessWorks
Application Development.

Output

In the Output tab, you can find the published changes of the tag values.

All the time is in UTC time zone.

The changes of the tag values are displayed under the following output items:

Output Item Data Type Description

header Complex The response message header.

serverName String The name of the PI server that stores the tag.

tagList Complex The tag value that is changed.

For descriptions of all the attributes in the previous three items, see Attributes in the Output Items.

Attributes in the Output Items
In this section, you can find the descriptions of all the attributes for the header, serverName, and
tagList items in the Output tab.

The following table provides the descriptions of all the attributes in the header item:

Attribute Name Data Type Description

consumer String The identifier of the message user.

provider String The identifier of the message provider.
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Attribute Name Data Type Description

timestamp String The date and time when the message is generated.

requestMessageId String The globally unique identifier of the request message.

responseMessageId String The globally unique identifier of the response message.

correlationId String The correlation identifier that can be used for
correlating multiple messages.

The following table provides the descriptions of all the attributes in the serverName and tagList items:

Attribute Name Data Type Description

serverName String The name of the PI server that stores the tag.

name String The unique name of the tag.

value String The tag value returned by the PI server.

If the value is not available for any reason, it is set to N/A.
And it is not relevant for Blob type tags.

binaryValue Binary The binary value of the tag returned by the PI server.

If the value is not available for any reason, it is set to N/A.
And it is relevant for Blob type tags only.

timestamp String The date and time when the tag value is generated.

isGood Boolean The attribute that identifies whether the tag value is
valid.

AF TagValues
By using the AF TagValues activity, you can set tag values and get tag values, including the most recent
value, the historical values, a specified number of historical values, and the archived value for a
specified time.

General

In the General tab, you can specify the name of the activity in the process, establish a connection to the
PI AF server, select which type of operation you want to use, and the type of value that you want to
retrieve.

The following table lists the fields in the General tab of the AF TagValues activity:

Field
Module
Property? Description

Name No A unique name of the activity in a process.
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Field
Module
Property? Description

Server
Connection

Yes The PI AF shared resource selected to connect to a PI AF server.

Click the  icon to select an OSIsoft PI System AF connection
resource. If no matching PI AF connection resource is found, click
Create Shared Resource to create one.

Operation No The type of operation you want to perform on the tag values:

● getTagValues: retrieves tag values.

● setTagValues: sets tag values.

Value Type No The type of value that you want to retrieve for the tag:

● Snapshot: the value with the most recent timestamp.

● ArcValue: the archived value with a specified timestamp.

● ValueHistory: the specified number of historical values if you
input a positive integer for the count parameter in the Input tab,
or the historical values within a specified time frame if you input
nothing for the count parameter in the Input tab.

This field is only available when you select getTagValues in
the Operation list.

Description

In the Description tab, you can type a short description for the AF TagValues activity.

Input

In the Input tab, you can specify the tag that you want to retrieve or set.

Input items in this tab are different depending on the operation name and value type you select in the
General tab:

● If you select the getTagValues operation, depending on the value type you select, different input
items are available:

Value Type Refer To

Snapshot getTagValues: Snapshot Input Items

ArcValue getTagValues: ArcValue Input Items

ValueHistory getTagValues: ValueHistory Input Items

● If you select the setTagValues operation, the following input items are available:

Input Item Data Type Description

requestHeader Complex The request message header
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Input Item Data Type Description

tagList Complex The list of tags and their attributes to be set

For descriptions of all the attributes in the previous two input items, see setTagValues: Input Items.

Output

In the Output tab, you can find the output results of the AF TagValues activity.

All the time is in UTC time zone.

Output items in this tab are different depending on the operation name and value type you select in the
General tab:

● If you select the getTagValues operation, depending on the value type you selected, different output
items are displayed:

Value Type Refer To

Snapshot getTagValues: Snapshot Output Items

ArcValue getTagValues: ArcValue Output Items

ValueHistory getTagValues: ValueHistory Output Items

● If you select the setTagValues operation, the following output items are displayed:

Output Item Data Type Description

responseHeader Complex The response message header

failureList Complex The list of failures

pointsUpdated Integer The number of tags that are successfully updated

Fault

In the Fault tab, you can find the error messages and error codes of the AF TagValues activity. For more
information about errors, see Error Codes.

The following table lists the error schema elements in the Fault tab:

Element Name Data Type Description

msg String Displays the error message.

msgCode String Displays the error code.
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getTagValues: Input Items
In this section, you can find the descriptions of the input items for the getTagValues operation
depending on the value type you select in the General tab.

Snapshot

The following table provides the descriptions of the input items for the Snapshot type of value:

Input Item Data Type Required Description

requestHeader Complex No The request message header.

tagList Complex Yes The list of tag names that you want to get
values for. You can add multiple tags in this list.

staleFrom String Yes The starting time of the stale period.

You have to specify both staleFrom
and staleTo, and the staleTo value
has to be more recent than the
staleFrom value.

staleTo String Yes The ending time of the stale period.

You have to specify both staleFrom
and staleTo, and the staleTo value
has to be more recent than the
staleFrom value.

ArcValue

The following table provides the descriptions of the input items for the ArcValue type of value:

Input Item Data Type Required Description

requestHeader Complex No The request message header.

tag String Yes The name of the tag that you want to get
historical values for.

timeStamp String No The timestamp of the requested value.

If you do not specify the value, "*" is filled in
this field, which means the current date and
time.

mode String No The attribute that determines how the value is
assigned to the timestamp.

Supported modes in this plug-in are Auto,
AtOrBefore, Before, AtOrAfter, After, and
Exact.

If you do not specify a value, Auto is filled in
this field.
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ValueHistory

The following table provides the descriptions of the input items for the ValueHistory type of value:

Input Item Data Type Required Description

requestHeader Complex No The request message header.

tag String Yes The name of the tag that you want to get
historical values for.

startTime String No The starting time for filtering results.

If you do not specify the value, "*" is filled in
this field, which means the current date and
time.

endTime String No The end time for filtering results.

count Integer No The number of values that are retrieved from
the starting time forwards or backwards.

isForward Boolean No The attribute that determines the timestamp
range for retrieving in relation to the specified
startTime:

● If it is set to false(), tag values with
timestamps that are less recent than the
specified startTime are retrieved. The tag
value are returned in time descending order.

● If it is set to true(), tag values with
timestamps that are more recent than the
specified startTime are retrieved.

If you do not specify the value, false() is filled
in this field by default.

boundaryType String No The attribute that determines which values are
returned in relation to the requested time
boundaries.

Supported boundary types in this plug-in are
Inside, Outside, and Interpolated.

If you do not specify the value, Inside is filled
in this field by default.

filterExp String No The PE syntax expression used for filtering
historical values.

For example, "'SINUSOID'>70" and
"'SINUSOID'<80".
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In version 6.0.0 of TIBCO ActiveMatrix BusinessWorks Plug-in for OSIsoft PI System, the input items
for the ValueHistory type are requestHeader, tag, startTime, endTime, boundaryType and
filterExp, the input items for the ValueHistoryByCount type are requestHeader, tag, startTime,
count, isForward, boundaryType and filterExp.

In version 6.1.0 of TIBCO ActiveMatrix BusinessWorks Plug-in for OSIsoft PI System, the ValueHistory
type and the ValueHistoryByCount type are merged into one type ValueHistory, but the input items
have the same meanings as in version 6.0.0.

setTagValues: Input Items
In this section, you can find the description of all the input items for the setTagValues operation.

The following table provides the descriptions of the input items for the setTagValues operation:

Input Item Data Type Required Description

Under requestHeader, the following input items are available:

consumer String No The identifier of the message user.

provider String No The identifier of the message provider.

timestamp String No The date and time when the message is
generated.

messageId String No The globally unique identifier of the message.

correlationId String No The correlation identifier that can be used for
correlating multiple messages.

Under tagList, the following input items are available:

name String Yes The unique name of a tag.

timestamp String No The date and time of the tag value.

mergeType String No The attribute that indicates how to deal with the
duplicated values in the archive file.

Supported values in this field are Replace,
Insert, NoReplace, ReplaceOnly,
InsertNoCompression, and Remove.

For more information, see the AFSDK
documentation.

value String Yes The value of the tag to be set on the PI server.

This value is not relevant for Blob
type tags.

binaryvalue Binary Yes The binary value of the tag to be set on the PI
server.

This value is relevant for Blob type
tags only.
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getTagValues: Output Items
In this section, you can find the descriptions of the output items for the getTagValues operation
depending on the value type you select in the General tab.

Snapshot

The following table provides the descriptions of the output items for the Snapshot type of value:

Output Item Data Type Description

responseHeader Complex The response message header.

failureList Complex A list of tags that are operated in the wrong way.

It is used as an output item in bulk tag operations where
some of the tag operations succeed and some fail.

For descriptions of the attributes in this item, see 
Attributes in the failureList item.

tagValueList Complex A list of current tag values stored on the PI server.

For descriptions of the attributes in this item, see 
Attributes in the tagValueList item.

Attributes in the failureList item

Attribute Name Data Type Description

tagName String The name of the tag under which the operation fails.

errorCode String The unique identification of the error.

errorDesc String The text description of the error.

Attributes in the tagValueList item

Attribute Name Data Type Description

name String The unique name of the tag name.

value String The tag value returned from the PI server.

If the value is not available for any reason, N/A is filled in this
field.

This value is not relevant for Blob type tags.

binaryValue Binary The binary value of the tag returned from the PI server.

If the value is not available for any reason, N/A is filled in this
field.

This value is only relevant for Blob type tags.

timestamp String The timestamp of the tag value.
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Attribute Name Data Type Description

isGood Boolean The attribute that identifies whether the tag is set to a valid
value.

isStale Boolean The attribute that identifies whether the last tag value change is
stale in relation to the stale period you specify in the getValues
request.

The value is relevant only when the staleFrom and staleTo
values are specified in the getValues request.

● If the last tag value change happens within the stale period,
isStale is set to true.

● If the last tag value change happens after the staleTo
value, isStale is set to false.

● If the last tag value change happens before the staleFrom
value, then the tag is omitted from the response message.

ArcValues

The following table provides the descriptions of the output items for the ArcValue type of value:

Output Item Data Type Description

responseHeader Complex The response message header.

arcValue Complex A single value associated to the timestamp.

For descriptions of the attributes in this element, see 
Attributes in the arcValue item.

Attributes in the arcValue item

Output Item Data Type Description

value String The archival value of the tag.

binaryValue Binary The archival binary value of the tag.

This value is only relevant to Blob type tags.

timestamp String The timestamp of the archival value of the tag.

ValueHistory

The following table provides the descriptions of the output items for the ValueHistory type of value:

Output Item Data Type Description

responseHeader Complex The response message header.
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Output Item Data Type Description

valueList Complex A list of historical values that match the filtering
criteria.

JDBC Query
By using the JDBC Query activity, you can retrieve tag definitions and retrieve the tag value with the
most recent timestamp or historical tag values within a specified time range.

The time zone of the data retrieved from the OSIsoft PI Server is the time zone of the OSIsoft PI Server.

General

In the General tab, you can specify the name of the activity in the process, establish a connection to the
PI JDBC server, select the type of operation you want to perform, specify and export the XSD schema.

The following table lists the fields in the General tab of the JDBC Query activity:

Field
Module
Property? Description

Name No A unique name of the activity in a process.

Server
Connection

Yes The PI JDBC shared resource selected to connect to a PI JDBC server.

Click the  icon to select an OSIsoft PI System JDBC connection
resource. If no matching PI JDBC connection resource is found, click
Create Shared Resource to create one.

Operation No The type of operation you want to perform:

● getSnapshot: gets the snapshot value that has the most recent
timestamp.

● getArcvalue: gets the historical values within a specified time
range.

● getTagDefinition: gets tag definitions.

Use Wildcards No The option that determines precise query or fuzzy query will be
performed on the PI server according to the tag names you enter in
the Input tab.

● If you select this check box, you can only enter one tag name in
the Input tab, and then fuzzy query is performed on the PI
server.

● If you do not select this check box, you can enter multiple tag
names in the Input tab, and then precise query is performed on
the PI server.

This check box is only available for the getSnapshot and
getTagDefinition operations.
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Field
Module
Property? Description

Attributes to
Export

No The list of value attributes that you can select to specify the schema
for the output data in the Output tab.

You can also load a customized output schema file for your JDBC
activity. For more information, see Customizing JDBC Output
Schema.

Export xsd
schema

No After finishing your selection in Attributes to Export or loading a
customized output schema file, click this button to export the
schema which is then displayed in the Output tab.

Description

In the Description tab, you can type a short description for the JDBC Query activity.

Input

In the Input tab, you can specify the tag name, time span, or both for your activity.

The input items are different depending on the operation type you select in the General tab:

Input Item Description

If you select the getSnapshot or getTagDefinition operation, the following input item is available:

TagName The name of the tag that you want to retrieve.

You can enter multiple tag names by right-clicking TagName and then
clicking Duplicate. But this operation is only applicable when the Use
Wildcards check box is cleared in the General tab.

If you select the getArcvalue operation, the following input items are available:

TagName The name of the tag that you want to retrieve.

StartTime The starting time of the time range within which you want to retrieve the
historical values.

EndTime The ending time of the time range within which you want to retrieve the
historical values.

Count The number of values that you want to retrieve.

Output

In the Output tab, you can find the output results structured in the schema you specify in the General
tab.

For the getSnapshot and getTagDefinition activities, results of only the tags that have matching data in
the PI server are returned.
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When you use the JDBC Query activity to get tag definitions, rounding errors might occur in the output
results of certain tag attributes. For example, the tag attribute "comdevpercent" which is set to 37%
might be output as 36.99999618.... For more information, see https://techsupport.osisoft.com/
Troubleshooting/Known-Issues/119059.

Fault

In the Fault tab, you can find the error messages and error codes of the JDBC Query activity. For more
information about errors, see Error Codes.

The following table lists the error schema elements in the Fault tab:

Element Name Data Type Description

msg String Displays the error message.

msgCode String Displays the error code.

Customizing JDBC Output Schema
The JDBC Query activity is provided with a defined schema for output that can be customized based on
your requirements.

Prerequisites

Ensure that you have created the schema file. For more information about the schema file format, refer
to the Meta-model-template.xml file under Example > Schemas > Template.

Procedure

1. From the menu, click Window > Preferences.

2. In the Preferences dialog, expand Tibco Plugins > OSIsoft PI System, and then click JDBC Output
Schema.
The JDBC Output Schema pane is displayed.

3. Next to the schema preference field, click Browse to specify the schema file that you have created.

4. Click OK. Your customized schema is ready to be loaded.
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Working with Sample Projects

To understand how TIBCO ActiveMatrix BusinessWorks Plug-in for OSIsoft PI System works, you can
run the sample projects packaged with the installer, which are located in the TIBCO_HOME/bw/
palettes/pi/version/samples directory.

The BigData Sample Project

The BigData sample project demonstrates the sending of PI tag change events to a Hadoop Distributed
File System (HDFS) by using the OSIsoft PI system plug-in and the Big Data plug-in. The Big Data
plug-in of version 6.2 is supported.

To run the processes in the BigData sample project, you must install TIBCO ActiveMatrix
BusinessWorks™ Plug-in for Big Data and configure the parameters.

The BigData sample project contains the following processes, and each process corresponds to a task:

● createschema.bwp

Run this process first to create the schema for uploading data to the Big Data server.
● ErrorHandler.bwp

This process is run automatically to check the errors when creating schema. You are not required to
run it.

● tagchanges.bwp

This process uses the AF TagEventListener activity to monitor and query tag changes.

The Example_AF Sample Project

The Example_AF sample project demonstrates the usage of the AF Server connection and the AF
activities.

You must configure the OSIsoft PI System AF connection correctly to run the PIAF process.

The Example_AF sample project contains one process, that is PIAF.bwp, which shows how to use the
AF activities to:

● Create and modify tags.
● Retrieve tag definitions.
● Set tag values.
● Retrieve tag values, including the latest tag value, the archival value with a specified timestamp, the

historical values within a specified time range, and a specified number of historical values.

The Example_JDBC Sample Project

The Example_JDBC sample project demonstrates the usage of the JDBC connection and the JDBC
Query activity.

You must configure the OSIsoft PI System JDBC connection correctly to run the processes in the
Example_JDBC sample project.

The Example_JDBC sample project contains the following processes, and each process corresponds to a
task:

● getArcvalues.bwp

This process shows how to use the JDBC Query activity to get a specified number of historical tag
values within a specified time range.
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● getSnapshot.bwp

This process shows how to use the JDBC Query activity to get the latest tag value.

● getTagDefinition.bwp

This process shows how to use the JDBC Query activity to get tag definitions.

● PIJDBC.bwp

This process shows how to use the JDBC Query activity to:

— Get tag definitions.

— Get the latest tag value.

— Get the historical tag values within a specified time range.

Importing the Sample Projects
Before running the sample projects, you must import them to TIBCO Business Studio.

Procedure

1. Start TIBCO Business Studio using one of the following ways:

● On Microsoft Windows: click Start > All Programs > TIBCO > TIBCO_HOME > TIBCO
Business Studio version_number > Studio for Designers.

● On Linux: run the TIBCO Business Studio executable file located in the TIBCO_HOME/studio/
version_number/eclipse directory.

2. From the menu, click File > Import.

3. In the Import dialog, expand the General folder and select Existing Studio Projects into
Workspace. Click Next.

4. Click Browse next to the Select archive file field to locate the sample. Click Finish.

Result

The sample projects are imported to TIBCO Business Studio.
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Running the Sample Processes
After importing the sample projects, you can run the processes in them to see how TIBCO ActiveMatrix
BusinessWorks Plug-in for OSIsoft PI System works.

Prerequisites

Ensure that you have imported the sample projects to TIBCO Business Studio. For more information,
see Importing the Sample Projects.

Procedure

1. In the Project Explorer view, expand the Resource folder, and then expand the example shared
resource.

2. Check that your connection is successful by completing one of the following steps:

● Double-click OSIsoftPISystemAFConnectionResource.piafResource to edit the OSIsoft PI
System AF connection, and then click Test Connection to validate your connection.

● Double-click OSIsoftPISystemJDBCConnectionResource.pijdbcResource to edit the OSIsoft
PI System JDBC connection, and then click Test Connection to validate your connection.

3. In the Project Explorer view, expand the Module Descriptors resource, and then double-click
Components.

4. In the Components editor, select the process that you do not want to run and click the  icon.
By default, all the processes for the application module are listed in the Components editor.

To run the processes in the BigData sample project, ensure that you have installed TIBCO
ActiveMatrix BusinessWorks™ Plug-in for Big Data.

5. On the toolbar, click the  icon to save your changes.

6. From the menu, click Run > Run Configurations to run the selected process.

7. In the Run Configurations dialog, expand BusinessWorks Application and click BWApplication.

8. From the right panel, click the Applications tab, and then select the check box next to
Example.application.

9. Click Run to run the process.

10. Click the  icon to stop the process.
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Managing Logs

When an error occurs, you can check logs to trace and troubleshoot the plug-in exceptions.

By default, error logs are displayed in the Console view when you run a process in debug mode. You
can change the log level of the plug-in to trace different messages and export the logs to a file. Different
log levels correspond to different messages. For more information, see Log Levels.

Log Levels
Different log levels include different information.

The plug-in supports the following log levels:

Log Level Description

Trace Includes all information regarding the running process.

Debug Indicates a developer-defined tracing message.

Info Indicates normal plug-in operations. No action is required. A tracing message
tagged with Info indicates that a significant processing step is reached, and
logged for tracking or auditing purposes. Only info messages preceding a
tracking identifier are considered as significant steps.

Warn Indicates that an abnormal condition occurred. Processing continues, but for
best practice, you can contact the administrator to investigate it.

Error Indicates that an unrecoverable error occurred. Depending on the severity of
the error, the plug-in might continue with the next operation or might stop.

Setting Up Log Levels
You can configure a different log level for the plug-in and plug-in activities to trace different messages.

By default, the plug-in uses the log level configured for TIBCO ActiveMatrix BusinessWorks. The
default log level of TIBCO ActiveMatrix BusinessWorks is Error.

Procedure

1. Navigate to the TIBCO_HOME/bw/version_number/config/design/logback directory and open
the logback.xml file.

2. Add the following nodes in the BusinessWorks Palette and Activity loggers area to specify a log
level for the plug-in:
<logger name="com.tibco.bw.palette.pijdbc.runtime">
   <level value="DEBUG"/>
</logger>

<logger name="com.tibco.bw.palette.pi.runtime">
   <level value="DEBUG"/>
</logger>

The value of the level tag can be Trace, Debug, Info, Warn, or Error.

If you set the log level to Debug, the input and output for the plug-in activities are also
displayed in the Console view. For more information about each log level, see Log Levels.
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3. Optional: Add the following nodes in the BusinessWorks Palette and Activity loggers area to
specify a log level for an AF or JDBC activity:
<logger name="com.tibco.bw.palette.pijdbc.runtime.ActivityName">
   <level value="DEBUG"/>
</logger>

<logger name="com.tibco.bw.palette.pi.runtime.ActivityName">
   <level value="DEBUG"/>
</logger>

For example, add the following node to set the log level of the AF TagDefinition activity to Debug:
<!--<logger name="com.tibco.bw.palette.pi.runtime.AFTagDefinition">
   <level value="DEBUG"/>
</logger>

The activities that are not configured with specific log levels use the log level configured
for the plug-in.

4. Save the file.

Exporting Logs to a File
You can update the logback.xml file to export plug-in logs to a file.

Procedure

1. Navigate to the TIBCO_HOME/bw/version_number/config/design/logback directory and open
the logback.xml file.

After deploying an application in TIBCO Enterprise Administrator, navigate to the
TIBCO_HOME/bw/version_number/domains/domain_name/appnodes/space_name/

node_name directory to find the logback.xml file.

2. Add the following node to specify the file where the log is exported:
<appender name="FILE" class="ch.qos.logback.core.FileAppender">
   <file>c:/bw6-osisoftpi.log</file>
      <encoder>
        <pattern>%d{HH:mm:ss.SSS} [%thread] %-5level %logger{36}-%msg%n</pattern>
      </encoder>
</appender>

The value of the file tag is the absolute path of the file that stores the exported log.

3. Add the following node to the root node at the bottom of the logback.xml file:
<root level="DEBUG">
   <appender-ref ref="STDOUT" />
   <appender-ref ref="FILE" />
</root>

4. Save the file.
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Error Codes

The following table lists the error codes, detailed explanations of them, and where applicable, ways to
solve them.

Error Code and Message Role Category Description Solution

TIBCO-BW-PALETTE-
PIAF-520001

Some error occured when

create/modify PIPoint

errorRole AF TagDefinition An error occurs
when creating or
modifying the PI
tag.

None

TIBCO-BW-PALETTE-
PIAF-530001

Exception occurred while

processing Output for

activity

errorRole AF
TagEventListener

An error occurs
when processing
output for the
activity.

None

TIBCO-BW-PALETTE-
PIAF-530002

There is no at least one

valid tag

errorRole AF
TagEventListener

No valid tags are
found.

Ensure that
the tags you
listen to exist
in the PI
server.

TIBCO-BW-PALETTE-
PIAF-530003

Exception occurred while

reconnecting detail

message is {0}

errorRole AF
TagEventListener

An error occurs
when
reconnecting to
the PI server.

None

TIBCO-BW-PALETTE-
PIJDBC-550001

IOException occurred

while retrieving XML

Output for activity

[{0}]

errorRole JDBC Query An error occurs
when retrieving
XML output for
the activity.

None

TIBCO-BW-PALETTE-
PIJDBC-550002

Exception occurred while

processing Output for

activity [{0} - {1}]

errorRole JDBC Query An error occurs
when processing
output for the
activity.

None

ERROR_OCCURED_RETRIE
VE_RESULT.errorCode=5000
01

IOException occurred

while retrieving XML

Output for activity

[{0}]

errorRole General An error occurs
when retrieving
XML output for
the activity.

None
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Error Code and Message Role Category Description Solution

ERROR_SHAREDSOURCE_
MISSING.errorCode=500002

Shared resource is

missing

errorRole General The shared
resource is
missing.

Check that a
connection
shared
resource is
selected from
the Server
Connection
list in the
General tab.

ERROR_OCCURED_INIT_G
ENERAL_MESSAGE.errorCo
de=500003

Exception occurred while

initialize input for

activity [{0} - {1}]

errorRole General An error occurs
when initializing
the input of the
activity.

None

ERROR_OCCURED_BUILD_
OUTPUT.errorCode=500004

Exception occurred while

processing Output for

activity detail message

is {0}

errorRole General An error occurs
when processing
output for the
activity.

None

ERROR_OCCURED_VALID
ATE_INPUT.errorCode=5000
05

The value of {0} field

should not be 0

errorRole General An error occurs
when entering 0
for the
parameter
count.

None
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